
 
 

The Right Tool For The Job 
Some Programs Just Don’t Cooperate 

 
Some Program Files Just Don't Cooperate with Other Programs. One of the more 
confusing areas you’re likely to encounter as a computer user is the wonderful world of 
file formats. Every software application on your computer that creates any type of data 
files (documents, pictures, or sound files, to name a few) has a particular structure for 
such files. When an application on your computer saves a file, it encodes the file so the 
application knows what to do with its contents when you open the file again. This coded 
information tells the program whether your file is a word processing document or a music 
file, as well as which program features it uses. 
 
For example, a presentation program, such as Microsoft PowerPoint or Lotus Freelance, 
equips saved files with information such as the screen size you used when preparing 
them. Files must also indicate the number of colors you used, as well as the location of 
individual slide elements, such as music, pictures, or video. A database or spreadsheet 
file includes the data you enter but also includes information on table structures, indexes, 
views, and forms and may or may not include password security and/or encryption 
information. 
 
The programmers who designed your program had reasons for creating its file structure 
the way they did. Sometimes this is a function of the way the software displays your 
document or plays your music. Sometimes it’s a way of keeping track of internal 
processes you don’t necessarily see, such as special embedded codes that make the print 
bold or the slide elements animate. Often, it’s a bit of both. 
 
As you can imagine, Microsoft’s programmers came up with a different way to store 
information produced by Microsoft Word than the folks at Corel use for WordPerfect or 
those at Lotus use for WordPro.  
 
If you only use one set of programs and never share your files with anyone else, this may 
never bother you. But if you’re like most users, you’ve probably upgraded your software 
one or more times over the years. This means you may occasionally discover you have to 
view a document created in an earlier version of your application, possibly one you 
stopped using years ago. Such situations can be a real problem. 
 
 
Today there are only two broad categories of microcomputers: PCs and Macs. True, they 
don’t use the same OSes, and programs written for one won’t work (or won’t work well) 
on the other without special emulator software. And it’s often the case that file formats 
for one platform aren’t the same as those used in the other, but there are ways to convert 



them. In addition, it’s rare today to find a program that won’t import files from 
competing programs and/or export data in formats other programs can read. 
   Common Ground. we’ll discuss file specific compatibility issues for a number of 
software applications, as well as how to deal with many of them. But there are a few 
more general items you should know first.  
 
For instance, sometimes you want to change a file format for reasons other than just 
getting a WordPerfect document to display in MS Works. We can think of two reasons 
right off the bat: avoiding macro viruses and speeding up transmission time.  
 
Documents created with programs containing their own automation languages (such as 
Word, Excel, Access, WordPerfect, Quattro Pro, Paradox, WordPro, and 1-2-3), can also 
contain inimical instructions written in those automation languages that can damage other 
files stored on your computer. We call such instructions macro viruses, after the small 
programs (or macros) you can create to record the keystrokes of repetitive tasks and 
assign that recording to a simpler keystroke combination. 
 
A macro virus usually travels by e-mail, as part of an attached document formatted and 
stored as the type of file associated with a specific program. The good news is there are a 
couple of ways to create documents that are unable to carry viruses. 
 
Rich Text Format. Most word processors and many other text-based programs (database 
and spreadsheet applications) can both save and open files in a generic text format called 
RTF (Rich Text Format; such files end in the extension .RTF).  
 
RTF files are useful because they preserve quite a bit of formatting information about 
your documents, including typeface, styles (such as bold, italics, and others), font size 
and color, and so on. RTF files will keep tables intact and can include embedded graphics 
and pictures. They may also preserve columns. What they generally don’t do is include 
automation code (macros), mail merge data, or formatting that is unique to a specific 
word processing program. 
 
When you convert a file to RTF, you strip it of most of the creating program’s proprietary 
code, solving three problems. First, the file is physically smaller, so it takes up less hard 
drive space and takes less time to send via e-mail. Second, no macros remain, so files 
can’t harm someone else’s computer. Third, you can open RTF files with virtually any 
other program that supports RTF imports on both PC and Mac computers. 
 
ASCII. Another option is to convert your data to the ASCII (American Standard Code for 
Information Interchange) format. This format uses a code representing English 
alphanumeric characters as numbers. ASCII expresses common characters, such as 
spaces, punctuation, numbers from zero to nine, and both uppercase and lowercase letters 
of the alphabet, using the numbers from 0 to 127 (the highest decimal number that can be 
rendered by 7 bits of data). For many years in the early days of computing, these 127 
characters were the sum total of the text that could be in an ASCII document. 
 



The advent of 8-bit computers (with an upper decimal limit of 256, or 0 to 255) resulted 
in an extension of the ASCII code to include many international characters (such as È and 
Ï) and symbols (such as © and ¥ or ®).  
 
ASCII text files do not carry formatting information of any kind. But because they do 
carry punctuation symbols and special characters, such as tabs, they are a popular way to 
exchange data among database and spreadsheet programs. In this case, a chosen character 
(commas and tabs or the pipe [|] are favorites) becomes a delimiter, separating fields 
within a database record or column boundaries in a spreadsheet row.  
 
ASCII files are smaller than their proprietary counterparts, making them easy to copy and 
paste into e-mail messages, and they eliminate macro virus worries. 
 
 
   New Converts. If you need to convert a file produced by one program to a format that 
another similar program can use, try one of the methods below. These steps assume that 
both permit you to copy and paste and you have both installed on your computer. 
 
Copy and paste. Launch both programs, and open the file you want to convert in the 
program that was used to create it. Place your cursor at the beginning of the document 
and select its entire contents. Depending on the program, do this either by pressing 
CTRL-A; by manually highlighting the file’s contents (clicking and dragging across its 
entire contents); by clicking the program’s Edit menu and clicking Select All; or by 
placing the cursor at the top of the document, holding the SHIFT key, and pressing 
CTRL-END. 
 
Next, click the Edit menu and click Copy (in some programs, you can also press CTRL-C 
or CTRL-INSERT). Switch to the application to which you wish to transfer the 
document, open a new document, and place the cursor at the beginning of the page. Now 
click the Edit menu and then Paste, or press CTRL-V or SHIFT-INSERT. 
 
A few things may go wrong when using this approach. One is that what you saw in the 
first document might not be what you get in the second. If there is a high degree of 
complexity in your original document (such as columns, graphics, special tricks with 
fonts that only the originating program can do, or numbered or bulleted outlines), some 
formatting features may not translate properly. Some programs (WordPerfect, for one) 
often substitute their own fonts and symbols instead of the standard ASCII codes, which 
may make your document look funny. Additionally, HTML (Hypertext Markup 
Language, the primary programming language used to create Web pages) features, such 
as underlined hyperlinks, may not transfer properly or at all. 
 
In such cases, try a different method that may work better, regardless of where the 
applications are located (both on your computer or one on yours and another on someone 
else’s). 
 



Import. This method requires a bit of investigation to find out what kinds of files the 
destination program can import. Most word processors can import files produced by 
competing products and many include format converters for old DOS programs, too. 
Likewise, many graphics applications support graphics file types other than their native 
formats. 
 
One key piece of information is the version number of the source program; your 
destination application may work with files from some versions and not others. However, 
it may be able to import an earlier version, and most products will let you save your work 
in an earlier file format if there is one. For example, WordPerfect 9 won’t import Word 
2000 files but will import Word 95 files, and Word 2000 lets you save your documents as 
Word 95 files.  
 
Similarly, Corel’s Ventura 8 isn’t designed to import CorelDRAW 9 or 10 files, but it 
will import files created by CorelDRAW version 8. Both CorelDRAW 9 and 10 let you 
save your graphics files in the older CorelDRAW 8 format. 
 
Once you’ve found out what the destination program can open, find out which formats 
your source program can export. When you save your file, click the File menu and then 
click Save As. If this is the first time you’ve saved it, look at the Save As dialog box. 
Many programs include Save As Type drop-down menus with choices of formats to use. 
It’s usually a good idea to save your file in the source program’s native format first. As 
we discussed above, the native format may contain information about your use of the 
program’s special features. 
Choices other than the program’s native format may only appear when you select File, 
Save As. In some cases, just to make life interesting, there may be a separate File, Export 
entry instead.  
 
Save the file in a format you know the destination program can open.  
 
How you open the file in the destination program will depend on the program and the 
format you used to save it. If you saved your file in the destination program’s native 
format, you should be able to open it normally (click File, then Open, and browse to the 
file’s location). Many modern applications also use File, Open to get files saved in other 
formats. Your program may rely on a combination of information in the file and the file’s 
extension (usually a three-letter code following a period at the end of the file name, such 
as .DOC, .WPD, .LWP, and others) to tell it how to get the file open and which of its 
built-in converters to use. In some cases, you may also need to look for a special Import 
command in the File menu (or a Place command if you’re using an Adobe desktop 
publishing program). 
 
Keep in mind that formats change as programs evolve, and going from new to old is often 
harder. For example, you can open a WordPerfect 4.2 for DOS file in the newest 
WordPerfect version, but you can’t automatically open a WordPerfect 10 for Windows 
file in your old DOS word processor. This is fairly common because as a software 



company adds new features, the older versions of a program can’t read the new file 
structures. 
 
There are a couple of approaches to solving this problem. The first is both 
straightforward and labor-intensive. As each new version of a program comes out, load 
and convert all your old documents. (While you’re at it, you may want to do the same 
thing whenever new storage media becomes available.) The second is to only convert old 
documents when you need them. This requires less footwork but carries with it the risk of 
having a vital document become unavailable. 
 
 
 
 
 
 
  


